
Chapter 2

Getting Started with
AutoCAD LT

After completing this chapter, you will be able to:
• Draw lines using the LINE command and its options.
• Understand various coordinate systems used in AutoCAD LT.
• Use the ERASE commands to clear the drawing area.
• Understand the two basic object selection methods: Window and Crossing options.
• Draw circles using the options of the CIRCLE command.
• Use the ZOOM and PAN display commands.
• Set up units using the UNITS command.
• Set up and determine limits for a given drawing.
• Plot drawings using the basic plotting options.
• Use the Options dialog box to specify settings.

Learning Objectives
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Figure 2-2  Invoking the LINE
command from the TOOL
PALETTES

DRAWING LINES IN AutoCAD LT

The most fundamental object in a drawing is the line.
A line can be drawn between any two points by using the LINE
command. You can invoke the LINE command by choosing the
Line button in the Draw toolbar (Figure 2-1), by choosing it from
the TOOL PALETTES (Figure 2-2), by choosing it from the Draw
menu, or by entering LINE at the Command prompt. Once you
have invoked the LINE command, the next prompt, Specify
first point, requires you to specify the starting point of the line.
You can either select a point using the pointing device or you can
enter its coordinates. After the first point is selected, AutoCAD LT
will prompt you to enter the second point at the Specify next
point or [Undo] prompt. At this point, you may continue to
select points or terminate the LINE command by pressing
ENTER, ESC, or the SPACEBAR. You can also right-click to
display the shortcut menu and choose the Enter or Cancel options
to exit from the LINE command. After terminating the LINE
command, AutoCAD LT will again display the Command prompt.
The prompt sequence for the drawing shown in Figure 2-3 is as
follows:

Command: LINE �
Specify first point: Move the cursor (mouse) and left-click to
specify the first point.
Specify next point or [Undo]: Move the cursor and left-click to specify the second point.
Specify next point or [Undo]: Specify the third point.
Specify next point or [Close/Undo]: ���(Press ENTER to exit the LINE command.)

The LINE command has the following three options.

Continue Close Undo

Tip
When you select the start point of the line by pressing the left mouse button, a rubber-band line
appears that stretches between the selected point and the current position of the cursor. This
line is sensitive to the movement of the cursor and helps you to select the direction and the
placement of the next point for the line.

Toolbar: Draw > Line
Tool Palettes: Command Tools > Line
Menu: Draw > Line
Command: LINE or L

Figure 2-1  Invoking the LINE command
from the Draw toolbar
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Note
To clear the drawing area to gain space to work out the exercises and examples, choose the Erase
button from the Modify toolbar or type ERASE at the Command prompt and press ENTER. The
screen crosshairs will change into a box called a pick box and AutoCAD LT will prompt you to
select objects. You can select the object by positioning the pick box anywhere on it and then
pressing the pick button of the pointing device. Once you have finished selecting the objects, press
ENTER to terminate the ERASE command and the selected objects will be erased. If you enter
All at the Select objects prompt, AutoCAD LT will erase all objects from the screen. (See
“Erasing Objects” discussed later in this chapter.) You can use the U (undo) command to undo
the last command by choosing the Undo button from the Standard toolbar.

Command: ERASE or E � (E is the command alias of the ERASE command.)
Select objects: Select objects. (Select objects using the pick box.)
Select objects: �

Command: ERASE �
Select objects: ALL �
Select objects: �
Command: U � (The U command will undo the last command.)

The Continue Option
After exiting the LINE command, you may want to draw another line starting from the point
where the previous line ended. In such cases, you can use the Continue option. This option
enables you to grab the endpoint of the previous line and continue drawing the line from that
point (Figure 2-4). The prompt sequence for the Continue option is given next.

Command: LINE or L ��(L is the command alias of the LINE command.)

Figure 2-3  Drawing lines using the LINE command
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Figure 2-5  Using the Close option with the
LINE command

Specify first point: Pick first point of the line.
Specify next point or [Undo]: Pick second
point.
Specify next point or [Undo]: �

Command: LINE �  (Or choose Repeat
LINE from the shortcut menu.)
Specify first point: �   (Press ENTER or
right-click to continue the line from the last line.)
Specify next point or [Undo]: Pick second
point of second line (third point in Figure 2-4).
Specify next point or [Undo]: �

Tip
You can also type the @ symbol to start
the line from the last point. For example, if you draw a circle and then immediately start the
LINE command, the @ will snap to the center point of the circle.

The Continue option snaps to the endpoint of the last line or arc even if other points have
been defined to draw entities such as circles, ellipses, and so on, after the line was drawn.

Command: LINE �
Specify first point: Pick first point of the line.
Specify next point or [Undo]: Pick second point.
Specify next point or [Undo]: �

Command: LINE or L �   (L is the command alias of the LINE command)
Specify first point: @ �   (Continues drawing the line from the last point.)
Specify next point or [Undo]:  Pick second point of the second line.
Specify next point or [Undo]: �

The Close Option
The Close option can be used to join the current
point with the initial point of the first line when
two or more lines are drawn in continuation.
For example, this option can be used when an
open figure needs one more line to close it and
make a polygon (a polygon is a closed figure
with at least three sides, for example, a triangle
or rectangle). The following is the prompt
sequence for the Close option (Figure 2-5).

Figure 2-4  Using the Continue option with the
LINE command
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Command: LINE �
Specify first point: Pick first point.
Specify next point or [Undo]: Pick second point.
Specify next point or [Undo]: Pick third point.
Specify next point or [Close/Undo]: Pick fourth point.
Specify next point or [Close/Undo]: C � (Joins the fourth point with the first point.)

You can also choose the Close option from the shortcut menu, which appears when you right-click
in the drawing area.

The Undo Option
If you draw a line, and then realize that you made an error, you can remove the line using the
Undo option of the LINE command. If you need to remove more than one line, you can use
this option multiple times and go as far back as you want. In this option, you can type Undo (or
just U) at the Specify next point or [Undo] prompt. You can also right-click to display the
shortcut menu, which gives you the Undo option. The following example illustrates the use of
the Undo option (Figure 2-6).

Command: LINE or L �    (L is the command alias of the LINE command)
Specify first point: Pick first point                     (Point 1 in Figure 2-6).
Specify next point or [Undo]: Pick second point (Point 2).
Specify next point or [Undo]: Pick third point.
Specify next point or [Close/Undo]: Pick fourth point.
Specify next point or [Close/Undo]: U �         (Removes last line from Point 3 to Point 4.)
Specify next point or [Close/Undo]: U �         (Removes next line from Point 2 to Point 3.)
Specify next point or [Close/Undo]: �

Figure 2-6  Removing lines using the Undo option of the LINE command
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Tip
AutoCAD LT allows you to enter the command aliases in place of the complete command
name. For example, you can enter L instead of LINE at the Command prompt to invoke the
LINE command.

Note
By default, whenever you open a new drawing, you need to modify the drawing display area. To
modify the display area, type ZOOM at the command prompt and press ENTER. In the
command sequence that appears, type ALL and press ENTER. The drawing display is modified.
You will learn more about the ZOOM command later in this chapter.

COORDINATE SYSTEMS
To specify a point in a plane, take two mutually perpendicular lines as references. The horizontal
line is called the X axis, and the vertical line is called the Y axis. The point of intersection of
these two axes is called the origin. The X and Y axes divide the XY plane into four parts,
generally known as quadrants. The X coordinate measures the horizontal distance from the
origin (how far left or right) on the X axis. The Y coordinate measures the vertical distance from
the origin (how far up or down) on the Y axis. The origin has the coordinate values of X = 0, Y
= 0. The origin is taken as the reference for locating any point on the XY plane. The X coordinate
is positive if measured to the right of the origin,
and negative if measured to the left of the
origin. The Y coordinate is positive if measured
above the origin, and negative if measured
below the origin. This method of specifying
points is called the Cartesian coordinate
system, see Figure 2-7. In AutoCAD LT, the
default origin is located at the lower left corner
of the graphics area of the screen. AutoCAD
LT uses the following coordinate systems to
locate a point in an XY plane.

1. Absolute coordinates

2. Relative coordinates
a. Relative rectangular coordinates
b. Relative polar coordinates

3. Direct distance entry

Absolute Coordinate System
In the absolute coordinate system, the points are located with respect to the origin (0,0). For
example, a point with X = 4 and Y = 3 is measured 4 units horizontally (displacement along the
X axis) and 3 units vertically (displacement along the Y axis) from the origin, as shown in
Figure 2-8.

Figure 2-7  Cartesian coordinate system
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In AutoCAD LT, the absolute coordinates are
specified by entering X and Y coordinates,
separated by a comma. The following example
illustrates the use of absolute coordinates
to draw the rectangle shown in Figure 2-9.

Command: LINE �
Specify first point: 1,1 �

            (X = 1 and Y = 1.)
Specify next point or [Undo]: 4,1 �
                              (X = 4 and Y = 1.)
Specify next point or [Undo]: 4,3 �
Specify next point or [Close /Undo]:
1,3 �
Specify next point or [Close/Undo]: 1,1
�
Specify next point or [Close/Undo]: �

For Figure 2-10, enter the absolute coordinates of the points in the following table. Then draw
the figure using the absolute coordinates. Save the drawing under the name Exam1.dwg.

            Point     Coordinates           Point     Coordinates
  1            3,1 5            5,2
  2            3,6 6            6,3
  3            4,6              7            7,3
  4            4,2              8            7,1

Figure 2-8  Absolute coordinate system

Figure 2-9  Drawing lines using the absolute
coordinates

Example 1 General
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Once the coordinates of the points are known, you can draw the figure by using the LINE
command. But before you proceed with drawing the object, you need to modify the drawing
display area. The prompt sequence is given next.

Command: ZOOM �
Specify corner of window, enter a scale factor (nX or nXP), or
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real time>: All �
Command: LINE �
Specify first point: 3,1 � (Start point.)
Specify next point or [Undo]: 3,6 �
Specify next point or [Undo]: 4,6 �
Specify next point or [Close/Undo]: 4,2 �
Specify next point or [Close/Undo]: 5,2 �
Specify next point or [Close/Undo]: 6,3 �
Specify next point or [Close/Undo]: 7,3 �
Specify next point or [Close/Undo]: 7,1 �
Specify next point or [Close/Undo]: 3,1 �
Specify next point or [Close/Undo]: �

Save this drawing. Choose the Save button from the Standard toolbar. The Save Drawing As
dialog box is displayed. Enter the name Exam1 in the File name edit box to replace Drawing1.dwg
and then choose the Save button. The drawing will be saved with the given name in the default
My Documents folder.

For Figure 2-11, enter the absolute coordinates of the points in the following table, and then use
these coordinates to draw the same figure. The distance between the dotted lines is 1 unit.

Figure 2-10  Drawing a figure using the absolute coordinates

Exercise 1 General
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Point Coordinates Point Coordinates
   1        2, 1    6           _______________
   2           _______________    7           _______________
   3           _______________    8           _______________
   4           _______________    9           _______________
   5           _______________

Relative Coordinate System
There are two types of relative coordinates: the relative rectangular and the relative polar.

Relative Rectangular Coordinates
In the relative rectangular coordinate system,
the displacements along the X and Y axes (DX
and DY) are measured with reference to the
previous point rather than to the origin. In
AutoCAD LT, the relative coordinate system
is designated by the symbol @ and it should
precede any relative entry. The following
prompt sequence illustrates the use of the
relative rectangular coordinate system to draw
a rectangle with the lower left corner at the
point (1,1). The length of the rectangle is 4
units and the width is 3 units (Figure 2-12).

Command: LINE �
Specify first point: 1,1 � (Start point)
Specify next point or [Undo]: @4,0 �       (Second point DX = 4, DY = 0.)

Figure 2-11 Drawing for Exercise 1

Figure 2-12  Drawing lines using the relative
rectangular coordinates
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Figure 2-13  Using relative rectangular coordinates with the LINE command

Specify next point or [Undo]: @0,3 � (Third point DX = 0, DY = 3.)
Specify next point or [Close/Undo]: @-4,0 � (Fourth point DX = -4, DY = 0.)
Specify next point or [Close/Undo]: @0,-3 � (Start point DX = 0, DY = -3.)
Specify next point or [Close/Undo]: �

Remember that if Dynamic Input is on, you need to input a comma (,) after entering the first
value in the dynamic input boxes. Else, AutoCAD LT will take coordinates in relative polar form.

Sign Convention. As just mentioned, in the relative rectangular coordinate system the
displacements along the X and Y axes are measured with respect to the previous point. Imagine
a horizontal line and a vertical line passing through the previous point so that you get four
quadrants. If the new point is located in the first quadrant, the displacements DX and DY are
both positive. If the new point is located in the third quadrant, the displacements DX and DY
are both negative. In other words, up or right are positive and down or left are negative.

Draw Figure 2-13 using the relative rectangular coordinates of the points given in the table that
follows.

Point Coordinates Point Coordinates
  1        3,1     8     @-1,-1
  2    @4,0     9     @-1,1
  3    @0,1   10     @-1,0
  4    @-1,0   11     @0,-2
  5    @1,1   12                  @1,-1
  6    @0,2   13     @-1,0
  7    @-1,0   14     @0,-1

Example 2 General
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Once you know the coordinates of the points, you can draw the figure using the LINE command
and entering the coordinates of the points. But before you proceed, you need to modify the
drawing display area, if not already done.

Command: ZOOM �
Specify corner of window, enter a scale factor (nX or nXP), or
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real time>: All �
Command: LINE �
Specify first point: 3,1 � (Start point)
Specify next point or [Undo]: @4,0 �
Specify next point or [Undo]: @0,1 �
Specify next point or [Close/Undo]: @-1,0 �
Specify next point or [Close/Undo]: @1,1 �
Specify next point or [Close/Undo]: @0,2 �
Specify next point or [Close/Undo]: @-1,0 �
Specify next point or [Close/Undo]: @-1,-1 �
Specify next point or [Close/Undo]: @-1,1 �
Specify next point or [Close/Undo]: @-1,0 �
Specify next point or [Close/Undo]: @0,-2 �
Specify next point or [Close/Undo]: @1,-1 �
Specify next point or [Close/Undo]: @-1,0 �
Specify next point or [Close/Undo]: @0,-1 �
Specify next point or [Close/Undo]: �

For Figure 2-14, enter the relative rectangular coordinates of the points in the following table,
and then use these coordinates to draw the figure. The distance between the dotted lines is 1
unit.

Point  Coordinates Point Coordinates
   1        2, 1    12            _______________
   2            _______________    13            _______________
   3            _______________    14            _______________
   4            _______________    15            _______________
   5            _______________    16            _______________
   6            _______________    17            _______________
   7            _______________    18            _______________
   8            _______________    19            _______________
   9            _______________    20            _______________
 10           _______________    21            _______________
 11           _______________    22            _______________

Exercise 2 General
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Relative Polar Coordinates
In the relative polar coordinate system, a point
is located by defining both the distance of the
point from the current point and the angle that
the line between the two points makes with the
positive X axis. The prompt sequence to draw
a line from a point at 1,1 to a point at a distance
of 5 units from the point (1,1), and at an angle
of 30-degree to the X axis (Figure 2-15) is given
next.

Command: LINE �
Specify first point: 1,1 �
Specify next point or [Undo]: @5<30 �

Note
If the Dynamic Input mode is on and you press the @ key, the relative polar coordinate mode
is activated and the second input box shows the angle value, preceded by the < symbol. Therefore,
you do not need to input the @ symbol. You can simply enter the distance value and then press the
TAB key to shift to the second input box for specifying the angle value. To enter values in the
relative polar coordinates, you need to input a comma after the first value.

Sign Convention. By default, in the relative polar coordinate system, the angle is measured
from the horizontal axis (3 ‘O’ clock) as the zero degree baseline. Also, the angle is positive if
measured in a counterclockwise direction and negative if measured in a clockwise direction.
Here, it is assumed that the default setup of the angle measurement has not been changed.

Note
You can modify the default settings of the angle measurement direction using the UNITS command,
which is discussed later.

Figure 2-14  Drawing for Exercise 2

Figure 2-15  Drawing a line using relative polar
coordinates
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For Figure 2-16, enter the relative polar coordinates of each point in the table, and then draw
the sketch. Use absolute coordinates for the start point (1.5, 1.75). The dimensions are shown in
the drawing. Also, save this drawing as Exam3.dwg.

Point Coordinates Point  Coordinates
   1   1.5,1.75     7   @1.0<180
   2   @1.0<90     8   @0.5<270
   3   @2.0<0     9   @1.0<0
   4   @2.0<30   10   @1.25<270
   5   @0.75<0   11   @0.75<180
   6   @1.25<-90 (or <270)   12   @2.0<150

Once you know the coordinates of the points, you can draw the sketch using the LINE command.
However, before drawing the sketch, modify the drawing display area using the ZOOM > All
command.

Command: LINE �
Specify first point: 1.5,1.75 � (Start point)
Specify next point or [Undo]: @1<90 �
Specify next point or [Undo]: @2.0<0 �
Specify next point or [Close/Undo]: @2<30 �
Specify next point or [Close/Undo]: @0.75<0 �
Specify next point or [Close/Undo]: @1.25<-90 �
Specify next point or [Close/Undo]: @1.0<180 �
Specify next point or [Close/Undo]: @0.5<270 �
Specify next point or [Close/Undo]: @1.0<0 �
Specify next point or [Close/Undo]: @1.25<270 �
Specify next point or [Close/Undo]: @0.75<180 �

Figure 2-16  Drawing for Example 3

Example 3 General
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Specify next point or [Close/Undo]: @2.0<150 �
Specify next point or [Close/Undo]: C � (Joins the last point with the first point.)

Save this drawing by choosing the Save button from the Standard toolbar. The Save Drawing As
dialog box is displayed. Enter the name Exam3 in the File name edit box and then choose the
Save button. The drawing will be saved with the given name in the default My Documents folder.

Draw the object shown in Figure 2-17 using the absolute, relative rectangular, and relative polar
coordinate systems to locate the points. Do not draw the dimensions; they are for reference only.

Direct Distance Entry
You can draw a line by specifying the length of
the line and its direction using Direct Distance
Entry (Figure 2-18). The direction is determined
by the position of the cursor, and the length of
the line is entered from the keyboard. If the
Ortho mode is on, you can draw lines along
the X or Y axis by specifying the length of the
line and positioning the cursor along the ortho
direction. You can also use it with the other draw
commands like the RECTANGLE command.
You can also use Direct Distance Entry with
polar tracking and SNAPANG. For example, if
SNAPANG is 45-degree and Ortho mode is off,
you can draw a line at 45 or 135-degree
direction by positioning the cursor and

Exercise 3 General

Figure 2-17  Drawing for Exercise 3

Figure 2-18  Using the Direct Distance Entry
method to draw lines
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entering the distance from the keyboard. Similarly, if  the polar tracking is on, you can position
the cursor at the predefined angles and then enter the length of the line from the keyboard.

Command: LINE �
Specify first point: Start point.
Specify next point or [Undo]: Position the cursor and then enter distance.
Specify next point or [Undo]: Position the cursor and then enter distance.

In this example, you will draw the object, as shown in Figure 2-19, using Direct Distance Entry.
The starting point is 2,2.

In this example, you will use the polar tracking option to draw lines. The polar tracking option
allows you to track lines that are drawn at the specified angles. The default angle that is specified
for polar tracking is 90-degree. As a result, you can use the polar tracking to draw lines at an
angle that is divisible by 90, such as 90, 180, 270, and 360. This is the reason you first need to
add another angle of 45-degree to the polar tracking that will allow you to track the lines drawn
at an angle divisible by 45, such as 45, 90, 135, and so on.

To add a 45-degree angle to polar tracking, right-click on the POLAR button on the status bar
and choose Settings from the shortcut menu. Select the Additional angles check box in the
Polar Angle Settings area and then choose the New button. Enter 45 in the field that appears and
then press ENTER. Choose OK to close the dialog box. Now, to turn the polar tracking on,
choose the POLAR button in the status bar. You can also turn polar tracking on or off while you
are in a command. As you move the cursor to draw lines now, AutoCAD LT displays a dotted line
when the position of the cursor matches one of the predefined angles for polar tracking. Also, a
tooltip is displayed that shows the length of the line and the angle at which it is being drawn.

Example 4 General

Figure 2-19  Drawing for Example 4
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The following is the Command prompt sequence for drawing the sketch in Figure 2-19. It is
presumed that you have modified the drawing display area.

Command: LINE �
Specify first point: 2,2
Specify next point or [Close/Undo]: Move the cursor horizontally toward the right and when the
dotted line and tooltip appear, enter 2.
Specify next point or [Close/Undo]: Move the cursor at an angle close to 45-degree and when the
dotted line and tooltip appear, enter 0.7071.
Specify next point or [Close/Undo]: Move the cursor vertically upward and when the dotted line
and tooltip appear, enter 1.
Specify next point or [Close/Undo]: Move the cursor horizontally toward the left and when the
dotted line and tooltip appear, enter 3.
Specify next point or [Close/Undo]: Move the cursor vertically downward and when the dotted
line and tooltip appear, enter 1.
Specify next point or [Close/Undo]: C

Note
You will learn more about polar tracking in Chapter 4, Working with Drawing Aids.

Use the direct distance entry method to draw a parallelogram. The base of the parallelogram
equals 4 units, the side equals 2.25 units, and the angle equals 45-degree. Draw the same
parallelogram using the absolute, relative, and polar coordinates. Note the differences and the
advantage of using direct distance entry.

ERASING OBJECTS

After drawing some objects, you may want to erase
some of them from the screen. To erase, you can use
the ERASE command (Figure 2-20). This command is used exactly the same way as an eraser is
used in manual drafting to remove the unwanted information. When you invoke the ERASE
command, a small box, known as the pick box, replaces the screen cursor. To erase an object,
move the pick box so that it touches the object. You can select the object by pressing the pick
button of your pointing device (Figure 2-21). AutoCAD LT confirms the selection by changing
the selected objects  into dashed lines, and the Select objects prompt returns. You can either
continue selecting objects or press ENTER to terminate the object selection process and erase
the selected objects. If you enter the command from the keyboard, you can type E or ERASE.
The prompt sequence is given next.

Exercise 4 General

Toolbar: Modify > Erase
Menu: Modify > Erase
Command: ERASE

Figure 2-20  Invoking the ERASE command
from the Modify toolbar
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Command: ERASE �
Select objects: Select first object.
Select objects: Select second object.
Select objects: �

If you enter All at the Select objects prompt,
AutoCAD LT will erase all objects in the drawing,
even if the objects are outside the screen display
area.

Command: ERASE �
Select objects: All
Select objects: �

You can also first select the objects to be erased
from the drawing and then right-click in the drawing area to display the shortcut menu. From
this menu, you can choose the Erase option.

CANCELING AND UNDOING A COMMAND
If you are in a command and you want to cancel or get out of it, press the ESC (Escape) key on
the keyboard.

Command: ERASE �
Select objects: Press ESC (Escape) to cancel the
command.

Similarly, sometimes you unintentionally erase
some object from the screen. When you discover
such an error, you can correct it by restoring the
erased object by means of the OOPS command.
The OOPS command restores objects that have
been accidentally erased by the previous ERASE
command, Figure 2-22. You can also use the U
(Undo) command to undo the last command.

Command: OOPS � (Restores erased objects.)
Command: U � (Undoes the last command.)

OBJECT SELECTION METHODS
One of the ways to select objects is to select them individually.  which can be time-consuming, if
you have a number of objects to edit. This problem can be solved by creating a selection set that
enables you to select several objects at a time. The selection set options can be used with those
commands that require object selection, such as ERASE and MOVE. There are many object
selection methods, such as All, Last, Add, and so on. At this point, you will learn two
options: Window and Crossing. The remaining options are discussed in Chapter 5.

Figure 2-21  Selecting objects by positioning the
pick box at the top of the object and then pressing
the pick button on the pointing device

Figure 2-22  Use of the OOPS command
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The Window Option*

This option is used to select an object or group
of objects by enclosing them in a box or
window. The objects to be selected should
be completely enclosed within the window;
those objects that lie partially inside the
boundaries of the window are not selected. You
can select the Window option by typing W at
the Select objects prompt. You are prompted
to select the two opposite corners of the
window. After selecting the first corner, you
can select the other corner by moving the
cursor to the desired position and specifying
the particular point. As you move the cursor,
a blue shaded window is displayed that changes
in size as you move the cursor. The objects
selected by the Window option are displayed
as dashed objects (Figure 2-23).

The prompt sequence for using the Window option with the ERASE command is given next.

Command: ERASE �
Select objects: W �
Specify first corner: Select the first corner.
Specify opposite corner: Select the second corner.
Select objects: �

You can also invoke the Window option by selecting a blank point on the screen at the Select
objects prompt. This is automatically taken as the first corner of the window. Moving the cursor
to the right will display a blue shaded window. After getting all the objects to be selected inside
this window, you can specify the other corner with your pointing device. The objects that are
completely enclosed within the window will be selected and highlighted. The following is the
prompt sequence for automatic window selection with the ERASE command.

Command: ERASE �
Select objects: Select a blank point as the first corner of the window.
Specify opposite corner: Drag the cursor to the right to select the other corner of the window.
Select objects: �

The Crossing Option*

This option is used to select an object or group of objects by creating a box or window around
them. The objects to be selected should be touching the window boundaries or completely
enclosed within it. You can invoke the Crossing option by entering C at the Select objects
prompt. After you choose the Crossing option, AutoCAD LT prompts you to select the first
corner at the Specify first corner prompt. Once you have selected the first corner, a shaded

Figure 2-23  Selecting objects using the Window
option



Getting Started with AutoCAD LT                                                                                  2-19

©
 C

A
D

C
IM

 T
ec

hn
ol

og
ie

s,
 U

S
A

. F
or

 e
ng

in
ee

ri
ng

 s
er

vi
ce

s,
 c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

dashed box or window of green color is drawn.
By moving the cursor, you can change the size
of the crossing box, hence putting the objects
to be selected within (or touching) the box.
Here, you can select the other corner. The
objects selected by the Crossing option are
highlighted by displaying them as dashed
objects, Figure 2-24. The following prompt
sequence illustrates the use of the Crossing
option when you choose the Erase button.

Select objects: C �
Specify first corner: Select the first corner
of the crossing window.
Specify opposite corner: Select the other
corner of the crossing window.
Select objects: �

You can also select the Crossing option automatically by selecting a blank point on the screen at
the Select objects: prompt and dragging the cursor to the left. The blank point you selected
becomes the first corner of the crossing window and AutoCAD LT will then prompt you to select
the other corner. As you move the cursor, a green shaded box or window drawn with dashed
lines is displayed. The objects that are touching or completely enclosed within the window will
be selected. The objects selected by the Crossing option are highlighted by being displayed as
dashed objects. The prompt sequence for automatic crossing selection when you choose the
Erase button is given next.

Select objects: Select a blank point as the first corner of the crossing window.
Specify opposite corner: Drag the cursor to the left to select the other corner of the crossing window.
Select objects: �

Note
With this release of AutoCAD LT, the entities
are highlighted when you move the cursor over
them. This feature is known as the Selection
Preview. The settings for the selection preview
are available in the Selection Preview area of
the Selection tab of the Options dialog box.
The PREVIEWEFFECT variable stores the type
of appearance during highlighting. The preview
will be a Dashed Line if the variable is set to
1, Thicken Line if it is set to 2, and Dashed
Thicken Line, if it is set to 3. The selection
preview for different values of  the
PREVIEWEFFECT variable is shown in
Figure 2-25

Figure 2-24  Selecting objects using the Crossing
option

Figure 2-25  The selection preview with
Both, Thicken, and Dash options
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DRAWING CIRCLES

To draw a circle, you can use the CIRCLE command. You
can invoke the CIRCLE command from the Draw
toolbar (Figure 2-26), from the TOOL PALETTES, or from
the Draw menu (Figure 2-27). The following is the
prompt sequence for the CIRCLE command.

Command: CIRCLE �
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]:

The options of the CIRCLE command are explained in the following sections.

The Center and Radius Option
In this option, you can draw a circle by defining the center and the radius of the circle, Figure 2-28.
After entering the CIRCLE command, AutoCAD LT will prompt you to enter the center of the
circle, which can be selected by specifying a point on the screen or by entering the coordinates
of the center point. Next, you will be prompted to enter the radius of the circle. Here you can
accept the default value, enter a new value, or select a point on the circumference of the circle to

Figure 2-27  Invoking the CIRCLE
command from the TOOL PALETTES

Toolbar: Draw > Circle
Tool Palettes: Command Tools > Line > Circle
Menu: Draw > Circle
Command: CIRCLE or C

Figure 2-26  Invoking the CIRCLE
command from the Draw toolbar
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specify the radius. The following is the prompt sequence for drawing a circle with a center at 3,2
and a radius of 1 unit.

Command: CIRCLE �
Specify center point for circle or [3P/2P/Ttr (tan tan radius): 3,2 �
Specify radius of circle or [Diameter]<current>: 1 �

Note
You can also set the radius by assigning a value to the CIRCLERAD system variable. The value
you assign becomes the default value for the radius.

The Center and Diameter Option
In this option you can draw a circle by defining the center and diameter of the circle. After
invoking the CIRCLE command, AutoCAD LT prompts you to enter the center of the circle,
which can be selected by specifying a point on the screen or by entering the coordinates of the
center point. Next, you will be prompted to enter the radius of the circle. At this prompt, enter
D. After this, you will be prompted to enter the diameter of the circle. For entering the diameter,
you can accept the default value, enter a new value, or drag the circle to the desired diameter and
select a point. If you use a menu option to select the CIRCLE command with the Diameter
option, the menu automatically enters the Diameter option and prompts for the diameter after
you specify the center. The following is the prompt sequence for drawing a circle with the center
at (2,3) and a diameter of 2 units, as shown in Figure 2-29.

Command: CIRCLE �
Specify center point for circle or [3P/2P/Ttr(tan tan radius): 2,3 �
Specify radius of circle or [Diameter]<current>: D �
Specify diameter of circle <current>: 2 �

Figure 2-29  A circle drawn by specifying its center
and diameter

Figure 2-28  A circle drawn by specifying its center
and radius
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The Two-Point Option
You can also draw a circle using the Two-Point option. In this option, AutoCAD LT lets you draw
the circle by specifying the two endpoints of the circle’s diameter. For example, if you want to
draw a circle that passes through the points (1,1) and (2,1), you can use the CIRCLE command
with 2P option, as shown in the following example (Figure 2-30).

Command: CIRCLE �
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 2P �
Specify first end point of circle’s diameter: 1,1 �
Specify second end point of circle’s diameter: 2,1 �       (You can also use the relative
coordinates.)

The Three-Point Option
For drawing a circle, you can also use the Three-Point option by defining three points on its
circumference. The three points may be entered in any order. To draw a circle that passes
through the points (3,3), (3,1), and (4,2), Figure 2-31, the prompt sequence is given next.

Command: CIRCLE �
Specify center point for circle or [3P/2P/Ttr(tan tan radius)]: 3P �
Specify first point on circle: 3,3 �
Specify second point on circle: 3,1 �
Specify third point on circle: 4,2 �

You can also use relative rectangular coordinates to define the points.

Command: CIRCLE �
Specify center point for circle or [3P/2P/Ttr(tan tan radius)]: 3P �
Specify first point on circle: 3,3 �
Specify second point on circle: @0,-2 �
Specify third point on circle: @1,1 �

Figure 2-31  A circle drawn using the 3 Point
option

Figure 2-30  A circle drawn using the 2 Point
option
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The Tangent Tangent Radius Option
A tangent is an object (line, circle, or arc) that contacts the circumference of a circle at only one
point. In this option, AutoCAD LT uses the Tangent object snap to locate two tangent points on
the selected objects that are to be tangents to the circle. Then you have to specify the radius of
the circle. The prompt sequence for drawing a circle using the Ttr option is given next.

Command: CIRCLE �
Specify center point for circle or [3P/2P/Ttr(tan tan radius)]: T �
Specify point on object for first tangent of circle: Select first line, circle, or arc.
Specify point on object for second tangent of circle: Select second line, circle, or arc.
Specify radius of circle <current>: 0.75 �

In Figures 2-32 through 2-35, the dotted circles represent the circles that are drawn by using the
Ttr option. The circle actually drawn depends on how you select the objects that are to be
tangent to the new circle. The figures show the effect of selecting different points on the objects.
If you specify too small or large radius, you may get unexpected results or the “Circle does not
exist” prompt.

Figure 2-33  Drawing a circle using the Tangent,
Tangent, Radius option

Figure 2-32  Drawing a circle using the Tan-
gent, Tangent, Radius option

Figure 2-34  Drawing a circle using the Tangent,
Tangent, Radius option

Figure 2-35  Drawing a circle using the Tangent,
Tangent, Radius option
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The Tangent, Tangent, Tangent Option
You can invoke this option from the menu bar. This option is a modification of the 3P option.
In this option,  AutoCAD LT uses the Tangent Object Snap to locate three points on three
selected objects to which the circle is drawn tangent. The following is the prompt sequence
for drawing a circle using the Tan, Tan, Tan option (Figure 2-36).

Command: Choose Draw > Circle > Tan, Tan, Tan from the menu bar.
_CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan
radius)]: _3p Specify first point on circle: _tan to Select the first object.
Specify second point on circle: _tan to  Select the second object.
Specify third point on circle: _tan to  Select the third object.

Draw Figure 2-37 using the various options of the LINE and CIRCLE commands. Use absolute,
relative rectangular, or relative polar coordinates for drawing the triangle. The vertices of the
triangle will be used as the center of the circles. The circles can be drawn using the Center and
Radius, Center and Diameter, or Tan, Tan, Tan options. (Height of triangle = 4.5 X
sin 60 = 3.897.) Do not draw the dimensions; they are for reference only.

Figure 2-36  Circle drawn using the Tan,Tan, Tan option

Exercise 5 Mechanical
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BASIC DISPLAY COMMANDS
Drawing in AutoCAD LT is much simpler than manual drafting in many ways. Sometimes while
drawing, it is very difficult to see and alter minute details. In AutoCAD LT, you can overcome
this problem by viewing only a specific portion of the drawing. This is done using the ZOOM
command. This command lets you enlarge or reduce the size of the drawing displayed on the
screen. Some of the drawing display commands such as ZOOM and PAN will be introduced
here. A detailed explanation of these commands and other display options appears in Chapter 7.

Zooming the Drawings

The ZOOM command (Figure 2-38) enlarges
or reduces the view of the drawing on the
screen, but it does not affect the actual size
of the entities. After the ZOOM command
has been invoked, (Figure 2-39) various
options can be used to obtain the desired
display. If you use a menu, it issues the
appropriate option at the initial ZOOM
prompt. The following is the prompt
sequence of the ZOOM command:

Command: ZOOM or Z �
Specify corner of window, enter a scale
factor (nX or nXP), or
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real time>:

Figure 2-37  Drawing for Exercise 5

Toolbar: Zoom toolbar, Standard > Zoom Window flyout
Menu: View > Zoom
Command: ZOOM

Figure 2-38  Selecting The ZOOM options from
the Standard toolbar
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Realtime Zooming
You can use the Realtime Zoom to zoom in
and zoom out interactively. To zoom in, invoke
the command, and then hold the pick button

down and move the cursor up. If you want to zoom in
further, bring the cursor down, specify a point, and
move the cursor up. Similarly, to zoom out, hold the
pick button down and move the cursor down. Realtime
zoom is the default setting for the ZOOM command.
At the Command prompt, pressing ENTER after
invoking the ZOOM command automatically invokes
the realtime zoom. To exit the Realtime Zoom,
right-click to display the shortcut menu and choose
Exit. You can also press ESC or the ENTER key to exit
the command.

Window Option
This is the most commonly used option of
the ZOOM command. It lets you specify the
area you want to zoom in on by letting you

specify two opposite corners of a rectangular window.
The center of the specified window becomes the center of the new display screen. The area
inside the window is magnified in size to fill the drawing area as completely as possible. The
points can be specified by selecting them with the help of the pointing device or by entering
their coordinates.

Previous Option
While working on a complex drawing, you may need to zoom in on a portion of the
drawing to edit some minute details. When you have completed the editing you may
want to return to the previous view. This can be done using the Previous option of the

ZOOM command. AutoCAD LT remembers the last ten views that can be restored using the
Previous option.

All Option
This option zooms to the drawing limits or the extents, whichever is greater. Whenever
you increase the limits (Quick Setup in Use a Wizard dialog box) the current display is
not affected and hence does not show. You need to use the Zoom All option to display

the limits of the drawing. Sometimes it is possible that the objects are drawn beyond the limits.
In such a case, the Zoom All option zooms to fill the drawn objects in the drawing area,
irrespective of its limits.

Note
You will learn about the other options of the ZOOM command in detail in Chapter 7.

Figure 2-39  Invoking the Zoom options
from the View menu
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Menu: Format > Units
Command: UNITS

Panning in Realtime
You can use Pan Realtime to pan the drawing interactively, by sliding the drawing and
placing it at the required position. To pan a drawing, invoke the command and then
hold the pick button down and move the cursor in any direction. When you select

realtime pan, AutoCAD LT displays an image of a hand, indicating that you are in the PAN
mode. You can drag the hand anywhere on the screen to move the drawing. To exit realtime pan,
right-click to display the shortcut menu and choose Exit. You can also press ESC or the ENTER
key to exit the command.

Tip
You can right-click to display a shortcut menu while the realtime zoom or realtime pan options
are active. The Realtime Zoom, Realtime Pan, Exit, and other ZOOM command options
are available in this shortcut menu.

SETTING UNITS

In Chapter 1 you have already learned to set units while starting a drawing from the Startup
dialog box using the Wizards option. If you want to change the units while you are already
working on a drawing, the UNITS command can be used.

Setting Units Using the Drawing Units Dialog Box
The UNITS command is used to select a format for the units of distance and angle measurement.
You can invoke this command using the Format menu. The UNITS command displays the
Drawing Units dialog box as shown in Figure 2-40. You can then specify the precision for the
units and angles from the corresponding Precision drop-down list, see Figure 2-41. You can
also set the units from the command line by entering -UNITS at the Command prompt.

Specifying Units
In the Drawing Units dialog box, you can select a desired format of units from the drop-down
list displayed when you choose the down arrow to the right of the Type edit box. You can select
one of the following five formats.

1. Architectural (0'-01/16") 2. Decimal (0.00) 3. Engineering (0'-0.00")
4. Fractional (0 1/16) 5. Scientific (0.00E+01)

If you select the scientific, decimal, or fractional format, you can enter the distances or coordinates
in any of these three formats, but not in engineering or architectural units. In the following
example, the units are set as decimal, scientific, fractional, and decimal and fractional to enter
the coordinates of different points.
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Command: LINE �
Specify from point: 1.75,0.75 � (Decimal.)
Specify next point or [Undo]: 1.75E+01,3.5E+00 � (Scientific.)
Specify next point or [Undo]: 10-3/8,8-3/4 � (Fractional.)
Specify next point or [Close/Undo]: 0.5,17/4 � (Decimal and fractional.)

If you choose the engineering or architectural format, you can enter the distances or coordinates
in any of the five formats. In the following example, the units are set as architectural; hence,
different formats are used to enter the coordinates of points.

Command: LINE �
Specify first point: 1-3/4,3/4 � (Fractional.)
Specify next point or [Undo]: 1'1-3/4",3-1/4 � (Architectural.)
Specify next point or [Undo]: 0'10.375,0’8.75 � (Engineering.)
Specify next point or [Close/Undo]: 0.5,4-1/4" � (Decimal and engineering.)

Note
The inch symbol (") is optional. For example, 1'1-3/4" is the same as 1'1-3/4, and 3/4" is the same
as 3/4.

You cannot use the feet (') or inch (") symbols if you have selected scientific, decimal, or fractional
unit formats.

Figure 2-41  Specifying the precision
from the Drawing Units dialog boxFigure 2-40  The Drawing Units dialog box
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Specifying Angle
You can select one of the following five angle measuring systems.

1. Decimal Degrees (0.00) 2. Deg/min/sec (0d00'00")
3. Grads (0.00g) 4. Radians (0.00r)
5. Surveyor’s Units (N 0d00'00" E)

If you select any of the first four measuring systems, you can enter the angle in the Decimal,
Degrees/minutes/seconds, Grads, or Radians system, but you cannot enter the angle in Surveyor’s
units. However, if you select Surveyor’s units, you can enter the angles in any of the five systems.
If you enter an angle value without any indication of a measuring system, it is taken in the
current system. To enter the value in another system, use the appropriate suffixes and symbols,
such as r (Radians), d (Degrees), g (Grads), or the others shown in the following examples. In
the following example, the system of angle measure is Surveyor’s units and different systems of
angle measure are used to define the angle of the line.

Command: LINE �
Specify first point: 3,3 �
Specify next point or [Undo]: @3<45.5 � (Decimal degrees.)
Specify next point or [Undo]: @3<90d30'45" � (Degrees/min/sec.)
Specify next point or [Close/Undo]: @3<75g � (Grads.)
Specify next point or [Close/Undo]: @3<N45d30'E � (Surveyor’s units.)

In Surveyor’s units, you must specify the
bearing angle that the line makes with the
north-south direction (Figure 2-42). For
example, if you want to define an angle of
60-degree with north, in the Surveyor’s units
the angle will be specified as N60dE.
Similarly, you can specify angles such as
S50dE, S50dW, and N75dW, as shown in
Figure 2-41. You cannot specify an angle that
exceeds 90-degree (N120E). The angles can
also be specified in radians or grads, for
example, 180-degree is equal to PI (3.14159)
radians. You can convert degrees into radians
or radians into degrees using the following
equations.

radians = degrees X 3.14159/180; degrees = radians X 180/3.14159

Grads are generally used in land surveys. There are 400 grads or 360-degree in a circle. A
90-degree angle is equal to 100 grads.

Figure 2-42  Specifying angle in Surveyor’s units
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Tip
An example corresponding to the type of unit and angle selected from the Length or Angle area
of the dialog box can be seen  in the Sample Output area of the dialog box.

In AutoCAD LT, by default the angles are positive if measured in the counterclockwise direction,
and negative if measured in the clockwise direction. Also, the angles are measured from the
positive X axis, see Figures 2-43 and 2-44. If you want the angles to be measured as positive in
the clockwise direction, select the Clockwise check box from the Angle area. Now, the angles
will be positive if measured in the clockwise direction, and the negative if measured in the
counterclockwise direction.

When you choose the Direction button in the Drawing Units dialog box, the Direction
Control dialog box appears, which gives you an option of selecting the setting for direction of
the base angle, see Figure 2-45.

If you select the Other option, you can set your own direction for the base angle by entering a
value in the Angle edit box or by choosing the Pick an Angle button to pick two points on the
screen to specify the angle. After selecting an angle, you can choose the OK button to apply the
settings. This will redisplay the Drawing Units dialog box.

You can also set the units of measure while inserting a block or a drawing from the DesignCenter.
In the Drawing Units dialog box, choose any measuring unit from the Units to scale
drag-and-drop content drop-down list, see Figure 2-46. Now, while inserting a block or a drawing
from the DesignCenter, AutoCAD LT inserts the block with the specified unit. Even if the block
was created using a different measuring unit, AutoCAD LT scales it and inserts it using the
specified measuring unit. If you want to insert the block with the original units, then choose
Unitless from the drop-down list.

Note
The insertion of blocks from the DesignCenter into a drawing is discussed in detail in Chapter 14.

Figure 2-44  Measuring angles counterclockwise
from the positive X axis (default)

Figure 2-43  North, South, East, and West
directions
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The Sample Output area in the Drawing Units dialog box shows an example of the current
format of the units and angles. When you change the type of length and angle measure in the
Length and Angle areas of the Drawing Units dialog box, the corresponding example is
displayed in the Sample Output area.

In this example, you will set the units for a drawing according to the following specifications
and then draw Figure 2-47. You also need to do the following.
a. Set the units of length to fractional, with the denominator of the smallest fraction equal to

32.

b. Set the angular measurement to surveyor’s units, with the number of fractional places for
display of angles equal to zero.

c. Set the direction to 90-degree (north) and the direction of measurement of angles to clockwise
(angles measured positive in clockwise direction), Figure 2-47.

Figure 2-45  Setting direction from the
Direction Control dialog box

Figure 2-46  Selecting the measuring
units for inserting drawings and blocks
using the drag-and-drop method

Example 5 General
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The procedure of completing this example is given in the following steps.

1. Invoke the Drawing Units dialog box by choosing Forma > Units from the menu bar. You
can also invoke the dialog box by entering UNITS at the Command prompt.

2. In the Length area of the dialog box, select Fractional from the Type drop-down list. From
the Precision drop-down list, select 0 1/32, see Figure 2-48.

Figure 2-47  Drawing for Example 5

Figure 2-48  Setting units for Example 5 in the Drawing Units dialog box
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3. In the Angle area of the dialog box, select Surveyor’s Units from the Type drop-down list.
From the Precision drop-down list select N 0d E, if it is not already selected. Also, select
the Clockwise check box to set the clockwise angle measurement as positive.

4. Choose the Direction button to display the Direction Control dialog box. Select the North
radio button. Choose the OK button to exit the Direction Control dialog box.

5. Choose the OK button to exit the Drawing Units dialog box.

6. With the units set, draw Figure 2-47 using the relative polar coordinates. Here the units are
fractional and the angles are measured from north (90-degree axis). Also, the angles are
measured as positive in the clockwise direction and negative in the counterclockwise
direction, see Figure 2-49.

7. Modify the drawing display area using the ZOOM > All command. Invoke the LINE
command and specify the points as follows.

Command: LINE �
Specify first point: 2,2��
Specify next point or [Undo]: @2.0<0 �
Specify next point or [Undo]: @2.0<60 �
Specify next point or [Close/Undo]: @1<180 �
Specify next point or [Close/Undo]: @1<90 �
Specify next point or [Close/Undo]: @1<180 �
Specify next point or [Close/Undo]: @2.0<60 �
Specify next point or [Close/Undo]: @0.5<90 �
Specify next point or [Close/Undo]: @2.0<180 �
Specify next point or [Close/Undo]: C �

Figure 2-49  Angles measured from north (Y axis)
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SETTING LIMITS OF THE DRAWING

In AutoCAD LT, the drawings must be drawn full scale and, therefore, the limits are needed to
size up a drawing area. The limits of the drawing area are usually determined by the following
factors.

1. The actual size of the drawing.
2. The space needed for putting down the dimensions, notes, bill of materials, and other

necessary details.
3. The space between various views so that the drawing does not look cluttered.
4. The space for the border and title block, if any.

In Chapter 1, you have already learned to set the limits while starting a drawing from the
Startup dialog box using the Wizards option. If you want to change the limits while you are
already working in a drawing, the LIMITS command can be used. When you start AutoCAD LT
using the Imperial file, the default limits are 12,9. The following is the prompt sequence of the
LIMITS command for setting the limits of 24,18.

Command: LIMITS �
Reset Model space limits:
Specify lower left corner or [ON/OFF]<current>: 0,0 �
Specify upper right corner <current>: 24,18 �

At the preceding two prompts you are required to specify the lower left corner and the upper
right corner of the sheet. Normally you choose (0,0) as the lower left corner, but you can enter
any other point. If the sheet size is 24 X 18, enter (24,18) as the coordinates of the upper
right corner.

Tip
Whenever you increase the drawing limits, the display area does not change. You need to use the
All option of the ZOOM command to display the complete area inside the drawing area.

Setting Limits
To get a good idea of how to set up limits, it is always better to draw a rough sketch of the drawing
to help calculate the area needed. For example, if an object has a front view size of 5 X 5, a side
view size of 3 X 5, and a top view size of 5 X 3, the limits should be set so that they can
accommodate the drawing and everything associated with it. In Figure 2-50, the space between
the front and side views is 4 units and between the front and top views is 3 units. Also, the space
between the border and the drawing is 5 units on the left, 5 units on the right, 3 units at the
bottom, and 2 units at the top. (The space between the views and between the borderline and the
drawing depends on the drawing.)

Menu: Format > Drawing Limits
Command: LIMITS
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After you know the sizes of various views and have determined the space required between views,
between the border and the drawing, and between the borderline and the edges of the paper,
you can calculate the space you need as follows.

Space along (X axis) = 1 + 5 + 5 + 4 + 3 + 5 + 1 = 24
Space along (Y axis) = 1 + 3 + 5 + 3 + 3 + 2 + 1 = 18

Thus, the space or work area you need for the drawing is 24 X 18. Once you have determined
the space, select the sheet size that can accommodate your drawing. In the case just explained,
you will select a D size (34 X 22) sheet. Therefore, the actual drawing limits are 34,22.

Limits for Architectural Drawings
Most architectural drawings are drawn at a scale of 1/4" = 1', 1/8" = 1', or 1/16" = 1'. You must set
the limits accordingly. The following example illustrates how to calculate the limits in architectural
drawings.

Given
Sheet size = 24 X 18
Scale is 1/4" = 1'

Calculate limits
Scale is 1/4" = 1'

or 1/4" = 12"
        or 1" = 48"
X limit = 24 X 48
        = 1152" or 1152 Units
        = 96'

Figure 2-50  Setting limits in a drawing
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Y limit = 18 X 48
        = 864" or 864 Units
        = 72'

Thus, the scale factor is 48 and the limits are 1152",864", or 96',72'.

In this example, you will calculate the limits and determine an appropriate drawing scale factor
for Figure 2-51. The drawing is to be plotted on a 12" X 9" sheet.

The scale factor can be calculated as follows:

Given or known
Overall length of the drawing = 31'
Length of the sheet = 12"
Approximate space between the drawing and the edges of the paper = 2"

Calculate scale factor
To calculate the scale factor, you have to try various scales until you find one that satisfies the
given conditions. After some experience you will find this fairly easy to do. For this example,
assume a scale factor of 1/4" = 1'.

Scale factor 1/4" = 1'      or 1" = 4'
Thus, a line 31' long will be = 31'/4' = 7.75" on paper. Similarly, a line 21' long = 21'/4' =
5.25".

Approximate space between the drawing and the edges of paper = 2"
Therefore, total length of the sheet = 7.75 + 2 + 2 = 11.75"

Example 6 General

Figure 2-51  Drawing for Example 6
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Similarly, total width of the sheet = 5.25 + 2 + 2 = 9.25"

Because you selected the scale 1/4" = 1', the drawing will definitely fit on the given sheet of
paper (12" x 9"). Therefore, the scale for this drawing is 1/4" = 1'.

Calculate limits
Scale factor = 1" = 48" or 1" = 4'
The length of the sheet is 12"
Therefore, X limit = 12 X 4' = 48'
Also, Y limit = 9 X 4' = 36'

Limits for Metric Drawings
When the drawing units are metric, you must use standard metric size sheets or calculate the
limits in millimeters (mm). For example, if the sheet size you decide to use is 24 X 18, the limits,
after conversion to the metric system, will be 609.6,457.2 (multiply length and width by 25.4).
You can round these numbers to the nearest whole numbers 610,457. Note that metric drawings
do not require any special setup, except for the limits. Metric drawings are like any other drawings
that use decimal units. As with architectural drawings, you can draw metric drawings to a scale.
For example, if the scale is 1:20, you must calculate the limits accordingly. The following example
illustrates how to calculate the limits for metric drawings.

Given
Sheet size = 24" X 18"
Scale = 1:20

Calculate limits
Scale is 1:20
Therefore, scale factor = 20
X limit = 24 X 25.4 X 20 = 12192 units
Y limit = 18 X 25.4 X 20 = 9144 units

Thus, the limits are 12192 and 9144.

Set the units of the drawing according to the following specifications and then make the drawing
shown in Figure 2-52 (leave a space of 3 to 5 units around the drawing for dimensioning and
title block). The space between the dotted lines is 1 unit.

1. Set UNITS to decimal units, with two digits to the right of the decimal point.

2. Set the angular measurement to decimal degrees, with the number of fractional places for
display of angles equal to 1.

3. Set the direction to 0-degree (east) and the direction of measurement of angles to
counterclockwise (angles measured positive in a counterclockwise direction).

Exercise 6 General
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4. Set the limits leaving a space of 3 to 5 units around the drawing for dimensioning and title
block.

INTRODUCTION TO PLOTTING DRAWINGS

Once you have created a drawing in the current session of AutoCAD LT, you may need
to have its hard copy for your reference or for sending to the client. This hard copy is
very useful in the industry and can be created by plotting and printing it on a sheet of

paper. Suppose you have drawn an architectural plan on the computer, you can print it and send
its hard copy to the site for implementation. Similarly, if you have created a mechanical component,
you can print it and send its hard copy to the shop floor for manufacturing. Drawings can be
plotted using the PLOT command. When you invoke this command, the Plot dialog box is
displayed, see Figure 2-53. By default, the dialog box is not expanded. To expand the dialog
box, choose the More Options button at the lower right corner of the dialog box.

The values in this dialog box are the ones that were set during the configuring of AutoCAD LT.
If the displayed values conform to your requirements, you can start plotting without making any
changes. If necessary, you can make changes in the default values according to your plotting
requirements.

Basic Plotting
In this section, you will learn to set up the basic plotting parameters. Later, you will learn about
the advance options that allow you to plot according to your plot drawing specifications. Basic
plotting involves selecting the correct output device (plotter), specifying the area to plot,
selecting paper size, specifying the plot origin, orientation, and the plot scale.

Figure 2-52  Drawing for Exercise 6

Toolbar: Standard toolbar > Plot
Menu: File > Plot
Command: PLOT or PRINT
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Figure 2-54  Drawing created in Example 3

You will plot the drawing shown in Figure 2-54 using the Window option to select the area to
plot. The drawing was drawn in Example 3 of this chapter and here it is assumed to be open on
the screen. Assume that AutoCAD LT is configured for two output devices: Default System
Printer and HP Laserjet 2100 Series PS.

Figure 2-53  The Plot dialog box

Example 7 General
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1. Invoke the Plot dialog box from the Standard toolbar, the File menu (choose Plot), or by
entering PLOT at the Command prompt. You can also invoke it by choosing Plot from the
shortcut menu, which is displayed by right-clicking on the Model/Layout tabs.

2. The name of the default system printer is displayed in the Name drop-down list in the
Printer/plotter area. In this example, it is HP Laser jet 2100 Series PS, see Figure 2-55.
You can use any other printer by selecting the name of the device from the Name
drop-down list.

Note
The default system printer varies from system to system. It is the printer chosen as the default
printer while configuring your system for the output device.

3. Select the Window option from the What to plot drop-down list in the Plot area area. The
dialog box is temporarily closed and the drawing area will appear. Now, select the two
opposite corners to define a window that specifies the plot area (the area you want to plot).
Note that the complete drawing, along with the dimensions should be enclosed in the
window. Once you have defined the two corners, the Plot dialog box will reappear.

4. To set the size for the plot, you can select a size from the drop-down list in the Paper size
area, which lists all the plotting sizes that the present plotter can support. You can select any

Figure 2-55  The Plot dialog box with the default printer
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one of the sizes listed in the dialog box or specify a size (width and height) of your own
through the Plotter Manager. (This option is discussed later in Chapter 12, Plotting
Drawings.) Once you select a size, you can also select the orientation of the paper. However,
to set the orientation, you need to expand the Plot dialog box by choosing the More
Options button at the lower right corner of the dialog box. The expanded form of this
dialog box is shown in Figure 2-56. To set the orientation, select the Landscape or Portrait
radio buttons from the Drawing orientation area. The sections in the Plot dialog box
related to paper size and orientation are automatically revised to reflect the new paper size
and orientation. In this example, you will specify A4 Paper size and Portrait orientation.

5. You can also modify values for the plot offset from the Plot offset area; the default values for
X and Y are 0. For this example, you can select the Center the plot check box to get the
drawing in the center of the paper.

6. In AutoCAD LT, you can enter values for the plot scale from the Plot scale area. Clear the Fit
to paper check box, if selected and then open the Scale drop-down list in the Plot scale
area to display the various scale factors. From this list, you can select a scale factor you want
to use. For example if you select the scale factor 1/4" = 1'-0", the edit boxes below the
drop-down list will show 1 inch = 48 units. If you want the drawing to be plotted so that it
fits on the specified sheet of paper, select the Fit to paper check box. When you select this
check box, AutoCAD LT will determine the scale factor and display it in the edit boxes. In

Figure 2-56  Expanded form of the Plot dialog box



2-42                                                                                              AutoCAD LT 2006 for Designers
©

 C
A

D
C

IM
 T

ec
hn

ol
og

ie
s,

 U
S

A
. F

or
 o

nl
in

e 
tr

ai
ni

ng
, c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

Figure 2-57  Plot preview with the shortcut menu

this example, you will plot the drawing so that it scales to fit the paper. Therefore, select the
Fit to paper check box and notice the change in the edit boxes. You can also enter your own
values in the edit boxes.

7. You can preview the plot on the specified paper size before actually plotting it. This way you
can save time and stationery. To preview a plot, choose the Preview button. Once regeneration
is complete, the preview image is displayed on the screen, see Figure 2-57. Here, in place of
the cursor, a realtime zoom icon is displayed. You can hold the pick button of your pointing
device and then move it up to zoom into the preview image and move the cursor down to
zoom out of the preview image.

8. If the plot preview is satisfactory, you can directly plot your drawing by choosing Plot from
the shortcut menu, as shown in Figure 2-57. If you want to make some changes in the
settings, choose Exit in the shortcut menu or press the ESC or the ENTER key to get back
to the dialog box. You can also choose the OK button in the dialog box to plot the drawing.



Getting Started with AutoCAD LT                                                                                  2-43

©
 C

A
D

C
IM

 T
ec

hn
ol

og
ie

s,
 U

S
A

. F
or

 e
ng

in
ee

ri
ng

 s
er

vi
ce

s,
 c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

MODIFYING AutoCAD LT SETTINGS USING THE OPTIONS
DIALOG BOX

You can use the Options dialog box to change the default settings that affect the drawing
environment or the AutoCAD LT interface and customizethem to your requirements using the
Options dialog box. For example, you can use this dialog box to turn off the settings to display
the shortcut menu by right-clicking or specify the support directories that contain the files you
need. The most convenient way of invoking this dialog box is by right-clicking in the
command window or in the drawing area when no command is active or no object is selected
and choosing Options from the shortcut menu. The Options dialog box is shown in Figure 2-58.

The dialog box contains eight tabs that display the sections to change the various environmental
aspects. The current profile and current drawing names are displayed on the top, above the tabs.
You can save a set of custom settings in a profile to be used later for other drawings. If you do not
specify a profile, the current settings are stored with the name Unnamed Profile. The various
tabs in the Options dialog box are discussed next.

Figure 2-58  The Options dialog box (Files tab)

Menu: Tools > Options
Command: OPTIONS
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Files
This tab stores the directories in which AutoCAD LT looks for the driver, support, menu, project,
template, and other files. It uses three icons: folder, paper stack, and file cabinet. The folder
icon is for a search path, the paper stack icon is for files, and the file cabinet icon is for a specific
folder. Suppose you want to know the path of the help file. You can select the Miscellaneous File
Names folder and then select the Help File icon to display the path, see Figure 2-57. Similarly,
you can define a custom hatch pattern file and then add its search path. This way AutoCAD LT
can locate the custom hatch pattern.
   
Display
This tab controls the drawing and window settings like tool tips display and scroll bar. For
example, if you do not want to display the tool tips, clear the Show ToolTips check box in the
Window Elements area. You can also change the color of the graphics window background,
layout window background, command line background, and also the color of the command line
text using the Color Options dialog box that is displayed by choosing the Colors button. This
tab also allows you to modify the display resolution and display performance. You can also set
the smoothness and resolutions of certain objects such as the circle, arc, rendered object, and
polyline curve. Here you can toggle on and off the various layout elements such as the layout tabs
on the screen, margins, paper background, and so on. You can also toggle on and off the display
performance such as the pan and zoom with raster images, apply the solid fills, and so on.

Open and Save
This tab controls the parameters related to opening and saving of files in AutoCAD LT. You can
specify the file type for saving while using the SAVEAS command. The various formats are
AutoCAD LT 2004 Drawing (*.dwg), AutoCAD LT 2000/LT2000 Drawing (*.dwg), AutoCAD
LT Drawing Template(*.dwt), AutoCAD LT 2004 DXF (*.dxf), AutoCAD LT 2000/LT2000
DXF(*.dxf), AutoCAD LT R12/LT2 DXF (*.dxf),  and so on. You can also set the various file
safety precautions such as the Automatic Save feature, or the creation of a backup copy. You can
add a password and digital signatures to your drawing while saving using the Security Options
button in the File Safety Precautions area. You can control the display of the digital signature
information when a file with a valid digital signature is opened with the help of the Display
digital signature information check box. You can change the number of recently saved files to
be displayed in the File menu for opening. You can also set the various parameters for external
references and the ObjectARX applications.

Plot and Publish
The Plotting tab controls the parameters related to the plotting and publishing of the drawings
in AutoCAD LT. You can set the default output device and also add a new plotter. You can set the
general parameters such as the layout or plot device paper size and the background processing
options while plotting or publishing. It is possible to select the spool alert for the system printer
and also the OLE plot quality. You can also set the parameters for the plot style such as using the
color-dependent plot styles or the named plot styles.
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System
This tab contains AutoCAD LT system settings options such as the 3D graphics display and
pointing device settings options where you can choose the pointing device driver. Here you can
also set the various system parameters such as the single drawing mode instead of MDE, the
display of the Startup option while opening a new session of AutoCAD LT and the OLE Properties
dialog box, and beep for wrong user input. You also have options to set the parameters for
database connectivity.

User Preferences
This tab controls settings that depend on the way the user prefers working on AutoCAD LT, such
as the right-click customization where you can change the shortcut menus. You can set the units
parameters for the DesignCenter as well as the priorities for various data entry methods. Here it
is possible to set the order of object sorting methods and also set the lineweight options.

Drafting
This tab controls settings such as the autosnap settings and the aperture size. Here you can also
set the toggles on and off for the various autotracking settings. Using this tab, you can also set
the tool tip appearance in the Model tab and layouts for Dynamic Input mode.

Selection
This tab controls settings related to the methods of object selection such as the grips, which
enables you to change the various grip colors and the grip size. You can also set the toggles on
or off for the various selection modes.

Note
The options in the various tabs of the Options dialog box have been discussed throughout the
book wherever applicable.

Tip
Some options in the various tabs of the Options dialog box have a drawing file icon in front
of them. For example, the options in the Display resolution of the Display tab have the
drawing file icons. This specifies that these parameters are saved with the current drawing only
and therefore affects it. The rest of the options (without the drawing file icon) are saved with
the current profile and also affect all the drawings present in that AutoCAD LT session.
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Self-Evaluation Test
Answer the following questions and then compare your answers to those given at the end of
this chapter.

1. You can draw a line by specifying the length of the line and its direction, using Direct
distance Entry. (T/F)

2. Using the Crossing method of object selection, only those objects that are completely
enclosed within the boundaries of the crossing box are selected. (T/F)

3. The Three-Point option of the CIRCLE command lets you draw the circle by specifying
the two endpoints of the circle’s diameter. (T/F)

4. If you choose the engineering or architectural format for units in the Drawing Units dialog
box, you can enter the distances or coordinates in any of the five formats. (T/F)

5. You can erase a previously drawn line using the __________ option of the LINE command.

6. The __________option of the CIRCLE command can be used to draw a circle, if you want
the circle to be tangent to two previously drawn objects.

7. The __________ command enlarges or reduces the view of the drawing on the screen, but it
does not affect the actual size of the entities.

8. After increasing the drawing limits, you need to use the __________ option of the ZOOM
command to display the complete area inside the drawing area.

9. In __________ units, you must specify the bearing angle that the line makes with the
north-south direction.

10. You can preview the plot before the actual plotting using the __________ button in the Plot
dialog box.

Answer the following questions.

1. In the Relative rectangular coordinate system, the displacements along the X and Y axes
(DX and DY) are measured with reference to the previous point rather than to the origin.
(T/F)

2. In AutoCAD LT, by default the angles are positive if measured in the counterclockwise
direction and the angles are measured from the positive X axis. (T/F)

Review Questions
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3. You can also invoke the PLOT command by choosing Plot from the shortcut menu, which
is displayed by right-clicking on the Command window. (T/F)

4. The Files tab of the Options dialog box stores the directories, in which AutoCAD LT looks
for the driver, support, menu, project, template, and other files. (T/F)

5. You cannot terminate the LINE command by pressing which of the following key on the
keyboard at the Specify next point or [Close/Undo]: prompt?

(a) SPACEBAR (b) BACKSPACE
(c) ENTER (d) ESC

6. Which of the following options of the ZOOM command zooms to the drawing limits or the
extents, whichever is greater?

(a) Previous (b) Window
(c) All (c) Realtime

7. How many formats of units can you choose from in the Drawing Units dialog box?

(a) Three (b) Five
(c) Six (d) Seven

8. Which of the following input methods cannot be used to invoke the OPTIONS command,
which displays the Options dialog box?

(a) Menu (b) Toolbar
(c) Shortcut menu (d) Command prompt

9. When you define the direction by specifying the angle, the output of the angle does not
depend on which one of the following factors.

(a) Angular units (b) Angle value
(c) Angle direction (d) Angle base

10. The __________ option of the LINE command can be used to join the current point with
the initial point of the first line when two or more lines are drawn in continuation.

11. The __________ option of drawing the circle cannot be invoked by entering the command
at the Command prompt.

12. When you select any type of unit and angle in the Length or Angle area of the Drawing
Units dialog box, the corresponding example is displayed in the __________ area of the
dialog box.
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Exercises

Exercise 7 General

Exercise 8 General

13. If you want the drawing to be plotted so that it fits on the specified sheet of paper, select the
__________ option in the Plot dialog box.

14. The __________ tab in the Options dialog box stores the details of all the profiles available
in the current drawing.

15. You can use the __________ command to change the settings that affect the drawing
environment or the AutoCAD LT interface.

Use the following relative rectangular and absolute coordinate values  in the LINE command to
draw the object.

Point Coordinates            Point Coordinates
   1   3.0, 3.0   5    @3.0,5.0
   2   @3,0   6    @3,0
   3   @-1.5,3.0   7    @-1.5,-3
   4   @-1.5,-3.0   8    @-1.5,3

For the drawing shown in Figure 2-59, enter the relative rectangular and relative polar coordinates
of the points in the following table, and then use these coordinates to draw the figure. The
distance between the dotted lines is 1 unit. Save this drawing as Exer8.dwg.

Figure 2-59  Drawing for Exercise 8
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  1     3.0, 1.0     9 _______________
  2 _______________   10 _______________
  3 _______________   11 _______________
  4 _______________   12 _______________
  5 _______________   13 _______________
  6 _______________   14 _______________
  7 _______________   15 _______________
  8 _______________   16 _______________

For the drawing shown in Figure 2-60, enter the relative polar coordinates of the points in the
following table. Then use these coordinates to draw the figure. Do not draw the dimensions.

Point   Coordinates            Point    Coordinates
  1       1.0, 1.0   6 _______________
  2 _______________   7 _______________
  3 _______________   8 _______________
  4 _______________   9 _______________
  5 _______________

Draw the sketch shown in Figure 2-61, using the LINE and CIRCLE commands. The distance
between the dotted lines is 1.0 units.

Exercise 9 Mechanical

Figure 2-60  Drawing for Exercise 9

Exercise 10 Mechanical
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Draw the sketch shown in Figure 2-62 using the LINE command and the Ttr option of the
CIRCLE command.

Set the units for a drawing according to the following specifications.
1. Set the UNITS to architectural, with the denominator of the smallest fraction equal to 16.
2. Set the angular measurement to degrees/minutes/seconds, with the number of fractional

places for display of angles equal to 0d00'.

Figure 2-61  Drawing for Exercise 10

Exercise 11 Mechanical

Figure 2-62  Drawing  for Exercise 11

Exercise 12 Mechanical
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Figure 2-64  Drawing for Exercise 13

3. Set the direction to 0-degree (east) and the direction of measurement of angles to
counterclockwise (angles measured positive in a counterclockwise direction).

Based on Figure 2-63, determine and set the limits of the drawing. The scale for this drawing is
1/4" = 1'. Leave enough space around the drawing for dimensioning and title block. (HINT:
Scale factor = 48; sheet size required is 12 x 9; therefore, the limits are 12 X 48, 9 X 48 = 576,
432. Use the ZOOM command and then select the All option to display the new limits.)

Draw the sketch shown in Figure 2-64. The distance between the dotted lines is 10 feet. Determine
the limits for this drawing and use the Architectural units with 0'-01/32" precision.

Figure 2-63  Drawing for Exercise 12

Exercise 13 Mechanical
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Exercise 14 General

Figure 2-65  Drawing for Exercise 14

Draw the object shown in Figure 2-65. The distance between the dotted lines is 5 inches. Determine
the limits for this drawing and use the Fractional units with 1 1/16 precision.

Draw the object shown in Figure 2-66. The distance between the dotted lines is 1 unit. Determine
the limits for this drawing and use the Decimal units with 0.00 precision.

Exercise 15 General

Figure 2-66  Drawing for Exercise 15
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Draw the object shown in Figure 2-67. The distance between the dotted lines is 10 feet. Determine
the limits for this drawing and use the Engineering units with 0'0.00" precision.

Draw the object shown in Figure 2-68, using the LINE and CIRCLE commands. In this
exercise only the diameters of the circles are given. To draw the lines and small circles (Dia 0.6),
you need to find the coordinate points for the lines and the center points of the circles. For
example, if the center of concentric circles is at 5,3.5, then the X coordinate of the lower left
corner of the rectangle is 5.0 - 2.4 = 2.6.

Exercise 16 General

Figure 2-67  Drawing for Exercise 16

Problem Solving Exercise 1 Mechanical

Figure 2-68  Drawing for Problem Solving Exercise 1
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Figure 2-69  Drawing for Problem Solving Exercise 2

Problem Solving Exercise 2 Mechanical

Draw the object shown in Figure 2-69 using various options of the CIRCLE and LINE commands.
In this exercise, you have to find the coordinate points for drawing the lines and circles. Also,
you need to determine the best and easiest method to draw the 0.85 diameter circles along the
outermost circle.

Draw the object shown in Figure 2-70 using the absolute, relative rectangular, or relative polar
coordinate system. Draw according to the dimensions shown in the figure, but do not dimension
the sketch. The dimensions are only for your reference.

Answers to Self-Evaluation Test
1 - T, 2 - F, 3 - F, 4 - T, 5 - Undo, 6 - Tan, Tan, Radius, 7 - ZOOM, 8 - All, 9 - Surveyor’s,
10 - Preview

Problem Solving Exercise 3 Mechanical

Figure 2-70  Drawing for Problem Solving Exercise 3


